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Chapter 1: Overview 
This guide introduces you to PRPC and provides hands-on instructions for modifying an application 
built on PRPC. It also introduces terms and demonstrates skills for application developers.  

The hands-on tasks involve working with a small application called ASupply. The application allows 
employees of ASupply to submit purchase order requests using their Web browser and automates 
the process of entering, routing, and approving purchase orders. 

The ASupply application is intentionally incomplete and simplified. Your assignment is to make 
changes and enhancements to it. The tasks presented in this book show you how to extend the 
application by adding and modifying rules to meet the needs of ASupply. By following these 
exercises, you will learn to: 

 Navigate within the Designer Studio 
 Change the rules to reflect new steps in a business process 
 Create rules that enhance the application user interface and behavior 
 Produce a Microsoft Word document that describes the application and lists its files, 

functions, and features. 
 

You make the modifications in a RuleSet designated for development. This guide takes you step-
by-step through each modification. 

Business Process Management 
According to the Business Process Management Group (at www.bpmg.org), Business Process 
Management (BPM) is the organizational activity "that incorporates: Planning, Designing, Building, 
Operating, Maintaining, and Improving the business processes and their enabling capabilities 
forever and for everyone. Business processes are capabilities, as important as facilities, people, 
and technology. Like all assets they must be managed from inception to retirement.” 

PRPC supports Business Process Management through rules for processes, assignments, routing, 
decisions, and automated processing. PRPC applications provide process management and 
automation through six functional capabilities, informally known as the Six R's: 

 Receiving — Accepting and capturing the essential data describing work from multiple 
sources, including keyboards, scanners, and external systems, in a wide range of media and 
formats. 

 Routing — Using characteristics of the work together with knowledge about the workforce 
to make intelligent matches and assignments. 

 Reporting — Providing real-time visibility of work in progress, work completed, 
productivity, bottlenecks, and quality. 

 Responding — Communicating status, requests for information, and progress to the work 
originator and to other people involved in the work, by e-mail, fax, written mail, and other 
means. 

 Researching — Accessing external systems and databases through connectors to support 
analysis and decision-making. 
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 Resolving — Completing the work and updating downstream systems promptly through 
automated processing and automated support of users. 

 

PRPC is the only BPM solution that automates both the business rules and the business processes 
that drive work to completion. 

Additionally, PRPC employs a sophisticated common object model to deliver the power of process 
and practice integration. This integration is achieved without the expense and resources associated 
with maintaining separate business process and rules databases, user interfaces, test 
environments, and production environments. 

Structure of This Guide 
This guide includes the following chapters and appendices. 

 Chapter 2 describes workstation and system settings 
 Chapter 3 demonstrates how users and managers use the ASupply application to enter and 

approve a purchase order request 
 Chapter 4 describes and guides you through the process of extending the application to 

change the purchase order request approval process 
 Chapter 5 describes and guides you through updates to the user interface 
 Chapter 6 reviews the tasks you completed in the previous chapters 
 Chapter 7 describes and guides you through the process of documenting your application 

using PRPC tools 
 Appendix A provides a sample of the system generated ASupply application document 
 Appendix B describes how to install the ASupply application 
 Appendix C describes how to contact Pegasystems for education services and 

documentation feedback 
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Prerequisites 
To follow the steps in the hands-on exercises in this book, you need: 

 Access to a PRPC  Version 6.3 SP1 system. This specific software version is required to 
accommodate the ASupply application that is used in the hands-on exercises. The installed 
Pega-ProcessCommander RuleSet version should not be lower than 06-03-10. 
 
Typically, the system administrator for your organization provides access to the 
organization’s installed PRPC system. The process for obtaining access is determined by 
your organization. Contact your system administrator to obtain the appropriate access and 
for assistance in verifying the version of the installed PRPC RuleSet. 

 The URL for logging into PRPC. The URL is usually obtained from your organization’s system 
administrator. It is typically in the format: 
http://<hostname>:<port>/prweb/PRServlet, where <hostname> is the system on 
which PRPC is installed and <port> is the assigned port. The URL is case sensitive. 

 The ASupply application. To install the application, follow the steps in Appendix D. If your 
organization has policies on who can install applications in PRPC, contact your organization’s 
system administrator for assistance. 

 Intel-based dual-core processor with at least 4GB of free RAM running a 32-bit or 64-bit 
version of Microsoft Windows 7   

 Microsoft Word to produce the Application document  
 Microsoft Internet Explorer (IE) version 7, 8, or 9 with current Microsoft security patches. All 

pop-up blockers, such as those provided by Yahoo! or Google toolbars, must be disabled.  
Chapter 2 describes Internet Explorer settings appropriate for using PRPC. 

Knowledgebase and Community 
The PDN, located at http:/pdn.pega.com, is the primary technical resource area for the PRPC 
community. It contains a broad range of technical articles including troubleshooting and how-to 
information as well as a comprehensive and searchable knowledgebase to help speed application 
development. 

 

http://pdn.pega.com/
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Chapter 2:  Getting Started   
This chapter describes the setup of your PRPC workstation and provides other information that 
helps ensure that you are ready to start your Personal Edition Fast Start tutorial. 

Topics include:  

 Internet Explorer settings 
 Temporary Internet File Settings 
 Downloaded program files 
 Other security settings 
 Performance tips and keyboard shortcuts 

Internet Explorer Settings 
PRPC works with Microsoft Internet Explorer Web browser version 7, 8, and 9 with current 
Microsoft security patches installed. To use the Designer Studio you must use Internet Explorer. 
The Case Worker and Case Manager portals also support Firefox 2+ and Safari. 

Internet Explorer, also referred to as IE or MSIE, serves as a thin client for both application 
developers and application users. All pop-up blockers such as those provided by Yahoo! or Google 
toolbars must be disabled. 

Several settings are important for best use of MSIE with PRPC. In many cases, these may 
correspond to the settings you normally use for Local intranet or other Local Zone processing. 

For additional settings not needed by most Personal Edition readers, select Help > Developer 
Help to open the PRPC help system, and search for the topics  How to set up Internet Explorer 7 
and How to set up Internet Explorer 8. 

Temporary Internet File Settings 
PRPC uses HTTP 1.1 and marks pages as expired when appropriate. To set this property in Internet 
Explorer version 7 and version 8, navigate to Tools > Internet Options > General and click the 
Settings button under Browsing history. Select Automatically in the Temporary Internet Files 
options. 

The system responds best if your MSIE cache is enabled, because the cache can store images and 
other static files locally. However, caching is not required. 

Downloaded Program Files 
PRPC uses a few ActiveX controls on the workstation. Each control automatically downloads on 
demand and only as needed if permitted by your Windows network account and browser settings. 

If your Windows account has Power User or Administrator privileges, you can download these 
controls. If not, another user with appropriate privileges can download them for you, by signing on 
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and using PRPC briefly. You do not need Power User or Administrator privileges to run the ActiveX 
controls. 

From the Windows Control Panel, double-click Internet Options, or from Internet Explorer, select 
Tools > Internet Options. On the Security tab, select the Local intranet zone to confirm that you 
can download signed ActiveX controls. You can set security for the Local intranet zone to Low, or 
you can select Custom level and enable the download settings (Figures 2-1 and 2-2). 

  

 Figure 2-1 Download Enabled 

 

 Figure 2-2 ActiveX Downloads Enabled 

Other Security Settings 
Typically, the PRPC server operates on a local area network (LAN) and appears in the Local internet 
zone of Windows Internet Properties and Internet Explorer Internet Options. You can adjust 
security settings for the Local internet zone without affecting the security settings you want to 
apply for the Internet zone. The default Local internet zone security setting of Medium or Medium-
Low is generally appropriate for PRPC use. Some special cases requiring customization are noted 
here.  

 Cookies — PRPC uses cookies. Confirm that your browser’s settings allow cookies. 
 Pop-up windows — Certain portal operations use pop-up windows. Pop-up blockers such 

as the Google toolbar may interfere with correct operation of these windows. 
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 Scripting — PRPC uses JavaScript. Applications based on PRPC may use VBScript or JScript 
in addition to JavaScript. Users must have the ability to execute scripts in the Local Zone. 
This is available under the Low setting for the Local intranet zone or as a custom setting. 

           

Performance Tips and Keyboard Shortcuts 
Personal Edition designers and users can be most productive if they and use these tips and 
shortcuts: 

 Do not use the browser’s Back button or Back keyboard shortcut.  
 Do not use the browser’s History capabilities to return to an earlier page. The older pages 

may contain stale information, and the browser’s Back and History features may interfere 
with session synchronization.  

 Click the Refresh button on the Designer Studio tab bar, not the Internet Explorer Refresh 
button or the F5 key, to refresh the current display. 

 Press CTRL+F to search for text on a page. 
 Press CTRL+P to print the current page. 
 Click the Home Icon  at the left of the Designer Studio tab bar to return to the Home 

display. 
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Chapter 3: Using the Application 
This chapter shows you how to use the application and experience it from the worker and manager 
points of view by: 

 Creating a purchase order request  
 Approving the purchase order request  

 
In Chapters 4 and 5, you assume the role of a designer and change the business process, 
appearance and functions supported by the application. 

Creating a Purchase Order 
1. Open your browser to the URL for logging into PRPC. The PRPC login screen appears  

(Figure 3-1). 
 

 

Figure 3-1 PRPC Login Screen 

The URL is usually obtained from your organization’s system administrator. It is typically in the format: 

http://<hostname>:<port>/prweb/PRServlet, where <hostname> is the system on which PRPC is installed and 

<port> is the assigned port. The URL is case sensitive. 
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2. Log into the system as WorkUser@ACORP.com with the password password to access the 
ASupply application. The Case Worker portal appears (Figure 3-3). 
 
If prompted with a Windows Security warning, click Install. Figure 3-2 shows an example. This 
might occur a few more times as Windows downloads each needed ActiveX control. 

 

Figure 3-2 ActiveX Control Warning 

 
This portal layout, for application users who are not managers, is known as the Case Worker 
portal. It provides a standard interface for users to create, view and work on their own cases 
and assignments. The colors, fonts and logo you see in this layout are customized for ASupply. 
PRPC provides defaults. You can build applications using your company’s standards and 
formats. 

3. Click the tab to display the My Worklist tab where you can view a list of outstanding (not 
complete) work assignments that are ready and waiting for the user to perform.  In this 
example, the worklist is empty, displaying the message No items. 
 

 

Figure 3-3 My Worklist 
 

4. Select Purchase Order from the New menu at the top left of the user portal (Figure 3-4). A 
tab labeled New is added and an entry form labeled Purchase Order displays in the main 
workspace. 

 

Figure 3- 4 New Menu Selection — Purchase Order 
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5. In the Purchase Order form, select IT from the Department Name selection list. In the 
Department Number field, type a number. Optionally, type a note in the Note field 
(Figure 3-5). 
 

 

Figure 3-5 New Purchase Order Entry Form 

6. Click Create at the bottom of the form. This action transmits your input to the PRPC server and 
creates a work item based on the purchase order process defined in the application. The 
system assigns a sequential identifier called the work item ID to the order. In this application, 
the work item IDs begin with the prefix, P-, to identify purchase orders. The ID replaces the 
New value in the work item tab (Figure 3-6).  
 

 

Figure 3-6 Purchase Order Request P-1 

7. Click the X   in the work item tab to close the request. The My Worklist tab 
displays. 



 
 

 
Fast Start Guide  

13 

8. On the   tab, click  to refresh the worklist. An assignment row for the purchase 
order appears on your worklist (Figure 3-7). It is added there because you need to take 
additional processing steps before your tasks associated with the order are complete.    

 

 

Figure 3-7  Purchase Order  added to Worklist 

An Urgency value is assigned to the order.  This is a number between 0 and 100 that indicates 
the importance (priority) of completing and resolving the work assignments. Here, the ASupply 
application initially assigns an urgency of 10 to a new assignment. As time passes, the urgency 
increases, reflecting the priority of completing the assignment. 

Note: You can exit from the ASupply application at any time by clicking Log off from the Work User menu, located 

in the upper left of the portal. Log off before closing the browser window.  

Do not use the Internet Explorer Back button. Instead, navigate using the tabs and buttons within the portal layout. 
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Adding Items to Your Purchase Order 
1. On your worklist, locate the purchase order you created. Double-click the ID to reopen the form 

for additional processing. The Enter Item Information section appears in the form (Figure 3-8). 
 

 

Figure 3-8 Enter Item Information Section 

2. In the Item Name column, select an item from the drop-down list. When an item is selected, 
its price appears in the Price column.  

3. Click in the Quantity field, enter a number for the quantity to be purchased and then press the 
Tab key. The total charge (price multiplied by quantity) appears for that line item. 

Note: Use the Tab key to advance from field to field. Do not use the Enter key -  pressing Enter submits the form. 
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4. Click the Add a row icon  to add another row. Select another item and enter its quantity. If 
you want, you can add additional rows and more items. Figure 2-9 shows an example. 

 
Figure 3-9   Purchase Order Line Items 

Note:  If you make a mistake and want to delete an item row, click the trash can  icon at the end of the row.  

5. Click Submit to move to the next step in the purchase order process.  If necessary, use the 
right-hand scroll bar to bring the Submit button into view. 

6. After clicking Submit, the Confirm Order section appears in the form.  Note the Confirm 
Order label circled in Figure 3-10. 

  

Figure 3-10  Confirm Order  
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To see where this processing point occurs within the overall Purchase Order process, click the 
Where Am I icon at the top of the tab. The You Are Here window opens and displays the 
process diagram (Figure 3-11). This is the processing path that the work item follows. The 
shapes in this diagram are types of building blocks in the PRPC representation of the business 
process. Common shapes are explained in more detail in Chapter 4. 

Check marks appear next to those process steps the work item has passed through and are 
complete. Following the diagram from the top downward, the work item was created and then 
was assigned to the Current Operator, the Work User. 

The first Assignment shape, the green rectangle labeled Enter Item Information, corresponds 
to the form where the user must select items and the quantities before the work item can 
continue through the process. When you clicked the Submit button, the work item moved to 
the next Assignment shape, labeled Confirm Order. The arrow shape indicates the current 
step of the flow. The P-1 work item is at the Confirm Order Assignment. 

  

 Figure 3-11 You Are Here Window 
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An Assignment shape is a green rectangle that corresponds to a human-based step in the 
flow. Assignments are points in the process that are scheduled to be handled by a person to 
provide input or take other actions. Here, the Confirm Order Assignment shape is where a 
user confirms the order and adds shipping details to the purchase order request. 

7. Click  to close the You Are Here window. 

8. Select the Add Shipping Information checkbox to display the shipping fields in the form 
(Figure 3-12).  

9. Type the shipping information for your purchase order. Use the Tab key to advance from 
field to field.  
 

 

Figure 3-12  Add Shipping Information 
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10. Click Submit. The Confirmation section displays (Figure 3-13). The Status is set to 
Pending-Approval. The form indicates that the work item has gone to a manager for 
approval. An assignment for the approval request is moved to the manager’s worklist. 
 

 

 Figure 3-13 Order in Pending-Approval Status 

In the ASupply Purchase Order process, the purchase order request automatically routes to a 
manager for approval when the order total is greater than $100. You can test this by 
creating a second purchase order request with a total of $100 or less. 

11. Close the form by clicking the X   in the work item tab. Then, click 
Log off to log out of the portal (Figure 3-14). 

 

 Figure 3-14 Logoff 
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Approving the Purchase Order Request 
Managers or supervisors have access to all of the facilities available to application users and more. 
In this sample application, managers have the ability to approve or reject certain purchase orders. 

1. Log into the system as Manager@ACORP.com with the password password to access the 
ASupply application as a manager. The Case Manager portal appears (Figure 3-16). 

Managers use different portal tabs and tools than their staff members.  When you are logged in 
as a manager, you may be prompted with a Windows Security warning (Figure 3-15) regarding 
one or a few additional ActiveX controls. Click Install each time this type of windows appears.   

  

Figure 3-15  ActiveX Control Warning 

2. In the ACORP Work Group, click Manager. The manager’s worklist appears in the work space 
on the right (Figure 3-16). 
 

 

Figure 3-16 Manager Portal 

  



 
 

 
Fast Start Guide  

20 

3. Double-click the purchase order’s work item ID to open it (Figure 3-17). 
 

 

Figure 3-17 Open Purchase Order 

4. Click Submit to approve the purchase order request. 
 

 

Figure 3-18 Approve Purchase Order 

An order confirmation displays (Figure 3-19). The resolved status indicates that the business 
process is complete. 
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Figure 3-19 Resolved-Completed Status 

Note: In this flow, after a manager Approves (or Rejects) the purchase order request, the work item becomes 

resolved with a status of Resolved-Completed (or Resolved-Rejected). 

Other tabs and tools in the Manager portal allow managers or supervisors to review staff 
member worklists, transfer work to/from staff members and review real-time reports about 
progress, volume, backlogs and trends. 

5. Close the item by clicking the Close  icon in the work item tab. Then click Logoff to log out 
of the portal (Figure 3-20).  
 

 

Figure 3-20 Logoff 
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Chapter 4: Extending the Application  
In this chapter, you work as a developer to extend the purchase order process to require a second 
approval on some purchase orders.  

To make the application more closely match ASupply’s business practices, you will modify the 
process flow to require a Vice President’s (VP) approval for those purchase order requests that 
meet all of the criteria for any row of the following table (Figure 4-1).  

At least one row must match the following business criteria for the purchase order to go to the VP 
for approval. 

Dept Name Bill Customer Order Total 
IT  >$1,000 

HR  >$500 

Finance No  

Finance Yes >$200 

Legal Yes >$200 

Legal No >$200 

IT No >$2,000 

Figure 4-1 ASupply Purchase Order VP Approval Criteria 

For example, according to this criteria table: 

If… Then 
The Department Name  set to Finance 

And 

the Bill Customer check box is not checked 

 VP approval is required, regardless of the total 

amount of the order 

However If… 
The Department Name is set to Finance  

The Bill Customer check box is checked   

The Order Total is $199.00 

No VP approval is required because none of the rows 

contain criteria that are all met – in this case the 

order total does not quality   
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When you complete the changes to the application to implement this policy, the revised process 
diagram will look like Figure 4-2, with the added shapes shown within the purple box. 

  

 Figure 4-2 Revised Process Diagram 

  



 
 

 
Fast Start Guide  

24 

Changing the Purchase Order Request Process 
Follow these steps to learn about the Designer Studio. The Designer Studio is the portal in which 
application designers and developers perform their work. 

1. Log into the system as Designer with the password password to access the Designer Studio. 

You may be prompted with a Windows Security warning (Figure 3-3) regarding one or a few 
additional ActiveX controls. Click Install each time this type of windows appears.   

  

Figure 4-3 ActiveX Control Warning 

The Designer Studio opens (Figure 4-4). If the Application Explorer is not the default display 
in the left panel, click  to select it from the list of Explorers. 

 

Figure 4- 4 Designer Studio 

The Application Explorer provides quick access to this application’s rules. It presents a multi-
level tree structure to browse for and perform operations on rules. Rules are organized into 
PRPC rule categories.  

For example, the ASupply application contains the PurchaseOrder class which contains rules 
that belong to various rule type categories such as Process, Decision and User Interface 
(Figure 4-5). 
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Figure 4-5 Process Rule Category in the Application Explorer 

2. Open the PurchaseOrder flow rule (Figure 3-6). 

a. Click the + icon to expand the PurchaseOrder class and see the rule categories it contains. 

b. Click the + icon to expand the  Process category to see the rule types it contains. 

c. Click the + icon to expand the Flow rule type. In the Application Explorer, a green arrow 
icon  preceding a flow name indicates a starter flow rule, which supports the creation of a 
new work item. 

d. Click PurchaseOrder to open the flow rule.  

  

Figure 4-6 PurchaseOrder Flow Rule in Application Explorer 
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The Flow rule form for the PurchaseOrder process opens (Figure 4-7).  

 

   Figure 4-7 PurchaseOrder Flow Rule 

PRPC has dozens of rule types. Each type is identified in the text label at the upper left of 
the corresponding form.  In this case the label is Flow.   

Tabs on the form provide access to rule fields and information organized by function. Tools 
on the Designer Studio toolbar enable you to find, create, change, or delete rules and data 
instances. The PurchaseOrder flow rule is marked by a read-only symbol  so you cannot 
alter this instance directly. Instead, you save a copy of this flow rule into a RuleSet named 
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ASupply with a higher RuleSet Version of 01-01-02. Then you make updates to the new 
copy. 

3. Click Save As  to save a copy of the flow rule into the ASupply:01-01-02 RuleSet 
Version. A SaveAs dialog box opens (Figure 4-8). 

  

Figure 4-8 Flow: Save As Dialog 

4. The Applies To and Flow Name fields identify the keys of the flow rule. Do not alter the 
values in these fields. The new flow rule should use the same keys as the original you are 
copying.  

Confirm that ASupply displays in the RuleSet drop-down list and the Version is 01-01-
02.   

Click Save As.  The new flow rule appears and the process diagram displays.  
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Select the arrow to collapse the details. 

 

The next steps change the PurchaseOrder flow to include a Decision shape that determines 
whether the VP must approve a purchase order request. 

A Decision shape, represented in the process diagram by an orange diamond , identifies 
an automatic step where processing may advance along any one of two or more outcomes. In 
this case, the Decision shape has two outcomes: 

 VP approval is required (True) 
 VP approval is not required (False) 
  

In the View area on the Diagram tab, make sure that Modeler is selected. Using the mouse 
wheel, scroll it towards you to reduce the size of the process diagram so you can view the 
entire process diagram. 

  

     

5.  In the toolbar, make sure that the Pan icon  is selected. Left-click on a blank area of the 
canvas and drag to move the diagram as a whole. You can use the mouse wheel to resize the 
diagram again. You can also pan the diagram using the mini-map in the lower right.  
 
For details about using the Process Modeler, click the  Help icon in the toolbar, select 
Developer Help, and go to the Flows — Process Modeler Basics topic. 

 

Figure 4-9 Developer Help 

Pan  and Select modes are mutually exclusive. When Select mode is on, you can 
left-click a blank area of the canvas and drag it to form a selection boundary. When you release 
the mouse button, the selected shapes are highlighted and you can take an action; for 
example, you can move or delete all the highlighted shapes simultaneously. You will work with 
Select mode later. 

6. In the toolbar, verify that Draft On  is selected. When the flow rule is in draft mode, 
it is known as a flow model and you can reference other rules and flow actions that you have 
not yet defined. 



 
 

 
Fast Start Guide  

29 

7. Review the process diagram.  
 

 

Figure 4-10 Process Modeler Process Diagram 

The green circle at the top of the process diagram identifies the start of the business 
process in which a new purchase order request is created. Processing of each purchase 
order proceeds along the connectors from shape to shape. 

The three green rectangles with clocks on them mark the Assignment shapes - Enter Item 
Information, Confirm Order and Manager Approve Order. Assignments are the steps in the 
process that require a human actor - here, a user or manager - to enter information or 
record their decisions. The orange diamond shape labeled Manager Review identifies an 
automated Decision. In this process, the automated Decision has two outcomes: Review or 
No Review. 
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8. In the toolbar, click  to open the Shapes palette. To pin the Shapes palette so that it is 
always visible, double-click the Shapes icon and drag the Shapes palette to the desired location 
as shown in Figure 4-11. You can hover the mouse pointer over each shape to view a 
descriptive ToolTip. 
 

 

Figure 4-11 Pinned Shapes Palette  
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9. Before adding a new Decision shape to the flow, create some space in the diagram. In the 

toolbar, click the Select mode. Click to the left of the process diagram, underneath Manager 
Approve, and drag to select the remainder of the flow: Update Status Completed, Update 
Status Rejected, Send Correspondence and their connectors, as shown in Figure 4-12.  
 

 

Figure 4-12 Select Shapes to Move 

10. When you release the mouse, selected areas of the flow are highlighted in blue. Hover the 

mouse pointer over the highlighted area until it changes to a cross .  Then click and drag the 
selected area down.  
 

 

      Figure 4-13 Click and Drag Shapes 
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The bounding box shown in Figure 4-14 indicates the new location. 
 

 

  Figure 4-14 Bounding Box Indicates New Location 

11. From the Shapes palette, drag a Decision shape   onto the process diagram, positioning it 
below the Manager Approve Order Assignment shape (Figure 3-15). This indicates that the 
business process requires a decision after a purchase order request is approved by the manager. 
 

 

Figure 4-15 New Decision Shape 

12. Hover the mouse pointer over the Decision shape until it changes to a cross . Then double-
click the Decision shape to display the Decision Properties panel. 
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Figure 4-16 Mouse Pointer Becomes a Cross 

13. In the Decision Properties panel, specify the following values.  

a. Type VP Approve Order in the Name field. This is the text that displays on the shape 
in the process diagram, the work item history display and the Where Am I diagram. 

b. Select Decision Table as the Type.  

c. Type VPApproveOrder in the Rule field. 

 
 
Figure 4-17 Decision Properties Dialog 

At this point, the flow rule references a decision table rule, but the decision table rule does not 
yet exist. Next, you’ll create the decision table rule. 

14. In the Decision Properties dialog, click the Open icon  next to the Rule field. You will 
create a new decision table rule with that name.  

 

 
 

  



 
 

 
Fast Start Guide  

34 

15. In the New Decision table dialog, confirm or enter the following: 

a. Do not change the Applies To field 

b. The Purpose field should be VPApproveOrder; if not, change it 

c. The RuleSet should be ASupply; if not, select it 

d. The Version should be 01-01-02; if not, select it 

 

Figure 4-18 New Decision Table Dialog 

16. Click Create. The Decision Table rule displays (Figure 4-19). 

 

 Figure 4-19 Decision Table Rule   
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Defining a New Decision Table Rule 
1. In the Decision Table rule form, click the Results tab to bring it to the front. Complete two 

rows of the Allowed Results array to identify the allowed results for this decision table. In this 
case, the allowed results are: 

True: This purchase order requires VP approval 

False: This purchase order does not require VP approval 

 When completing table arrays, click:  

  to add a new row at the bottom of the array 

  to insert a new row between existing rows 

  to delete a row 

2. On the Results tab, type True in the first row, click  to add a new row and type False in the 
second row. 

 

Figure 4-20 Decision Table Rule – ResultsTab 

Note:  No changes are needed to the Set Properties?, Options or Preset Property Values areas. 
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3. Click the Table tab to bring it to the front. In this tab, you record the decision table logic 
previously presented in Figure 4-1. 

Dept Name Bill Customer Order Total 
IT  >$1,000 

HR  >$500 

Finance No  

Finance Yes >$200 

Legal Yes >$200 

Legal No >$200 

IT No >$2,000 

Figure 4-21 Decision Table Logic 

4. The decision table has three inputs that are identified by property rules: DepartmentName, 
BillCustomer and OrderTotal. Each column in the decision table, except the Return column, 
corresponds to a property. Use these steps to complete the Table tab. 

a. Click the column heading cell located just below the Conditions column title to label the 
column in the matrix. A Property Chooser pop-up dialog displays (Figure 4-22). 

  

          Figure 4-22 Decision Table Property Chooser 
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b. With the mouse pointer in the Property field, press the Down Arrow key  to use the 
SmartPrompt control to access a list of available properties. When DepartmentName 
(Figure 3-23) is highlighted, press Enter to select it. You can also double-click to select 
an item from a SmartPrompt control. 

  

         Figure 4-23 Select A Property – Decision Table Property Chooser  

After you choose the DepartmentName property, the Label field displays a default 
value. 

Note: The green triangle at the bottom right corner of the Rule field is a SmartPrompt control. SmartPrompts 

appear on many rule and data forms to provide a selection list for fast entry. To complete a field that contains 

this control, press your keyboard’s Down Arrow key to access the list. For the Property field here, this 

SmartPrompt control displays a list of available properties from which you can select. 

c. Click Save to save the property to the decision table matrix. 

5. The starting table contains a single input Conditions column. You need to add two columns - 
one for the BillCustomer property and one for the OrderTotal property. 

To add a column to the right of the starting column: 

a. Click the cell under Department Name to select that column  
(Figure 4-24). 

 

         Figure 4-24 Decision Table Rule – Select A Column 

 

b. Click the Insert Column After icon . A new column appears to the right of the 
starting column. Do this again to add a second column (Figure 4-25). 



 
 

 
Fast Start Guide  

38 

 

        Figure 4-25 Decision Table Rule – Insert Column After 

6. Add the BillCustomer and OrderTotal properties (Figure 4-26) to the columns using the 
Property Chooser. 

   

 

Figure 4-26 Decision Table Rule – Add Properties To Columns  

7. Enter the first decision criteria shown in Figure 4-21 to complete the first row of your decision 
table: 

a. Click in the first cell under Department Name. The SmartPrompt appears in the cell. 
Press the Down Arrow key  to display the selection list and enter the name IT. 

b. Under Bill Customer, leave the entry blank for this row.  

c. Type >1000 for the entry under Order Total. Omit the dollar sign, commas and 
pennies in the amount. 

d. In the Actions Return column, select True for the value (Figure 4-27). There are only 
two allowed return actions, True and False, which are defined by the results that you 
specified earlier on the Results tab. 

 

         Figure 4-27 Decision Table Rule – First Row Completed  
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8. Add additional rows by clicking the Insert Row After icon . Add six rows.

 

Figure 4-28 Decision Table Rule – Empty Rows Added 

9. Using the table in Figure 4-1 as your guide, complete the table so it looks like Figure 4-29. In 
the Bill Customer column, enter =False for No and =True for Yes. In the otherwise (final) 
row, set the return action to False. 
 

  

Figure 4-29 Decision Table Rule Completed  
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10. Click Save to save the updated decision table rule. An icon at the top of the form indicates 
that the rule was saved, but with a warning. Click the + sign to view the warning. 
 

 

Figure 4-30 Decision Table Rule Warning 
 

Click Show Conflicts to check this rule for logic consistency (Figure 4-31). One logic error 
appears in the bottom row indicated by a warning icon .   

The row contains an unreachable condition. It has a combination of input values that cannot be 
used. The top row is reached first (IT and order total > 1000) and masks the bottom row (IT 
and order total > 2000). 

 

Figure 4-31 Decision Table Rule – Logic Errors  
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11. To delete this row, click in any cell in the row to select the row and select the Delete Row icon

. Click Show Conflicts again to confirm that no logic errors remain. A message displays: 
The Decision Table is consistent.  

12. Click Save to save the revised decision table. Close the rule form by clicking the X. 
 

 

13. Click OK to close the Decision Properties dialog. The label on the Decision shape is updated to 
VPApproveOrder. 
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Editing the Flow 

1. Move the Manager Approve connector from the Update Status Completed Utility shape to 
the VP Approve Order Decision shape. To do this, select the Manager Approve connector. 
The connector displays in blue and connection points appear as dots at either end of the 
connector. 

 

Figure 4-32 Select Connector 

2. Click and drag the connection point from the Update Status Completed Utility shape to the 
top connector of the VP Approve Order Decision shape. A connector must make a valid 
connection to a shape. Valid connections display with a green connector line and a green outline 
around the target shape (Figure 4-33). 
 

 

Figure 4-33 Move Connector  
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3. Select and drag an Assignment shape below the VP Approve Order Decision shape, so that 
purchase order requests can be routed to the Vice President (Figure 4-34). 
 

 

Figure 4-34 Add Assignment Shape 
 

4. Hover the mouse pointer over the Assignment shape until it changes to a cross , and then 
double-click the Assignment shape and complete the Assignment Properties. On the 
Assignment tab, complete the following (Figure 4-35): 

a. Name: Type VP Approval 

b. Harness Name: Use the SmartPrompt to select Perform   
A harness rule provides the basis of a form for work item processing.  

c. Instructions: Type VP Approval Pending  
Do not include punctuation. This text will appear in the Confirm user form. 

d. Confirmation Note: Type VP Approval is required 
Do not include punctuation.  
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 Figure 4-35 Assignment Properties  

5. In the Status tab, use the SmartPrompt to select Pending-Approval as the Work Status.  
 

 

Figure 4-36 Assignment Properties – Status  

6. In the Routing tab, use the SmartPrompt to select ToVP as the Router. Click OK to apply the 
assignment properties. 
 

 

     Figure 4-37 Assignment Properties– Routing 

7. Add a connector from the VP Approve Order Decision shape to the Update Status 
Completed Utility shape as shown in Figure 4-38. To add a connector, click and drag a gray 
arrow on the VP Approve Order Decision shape and drop it on the Update Status 
Completed Utility shape. 
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Figure 4-38 Add Connector  

8. Double-click the connector to open the Connector Properties and configure this connector as 
shown in Figure 4-39. Set the Likelihood to 50. A likelihood is a value between 1 and 100. It 
reflects an assumed or known probability of the human actor taking that action. Click OK. 
 

 

Figure 4-39 Configure Connector  

This configuration means that when the decision table rule returns a value of False, the Vice 
President’s approval is not required. The following events occur automatically. 

 The request’s status is updated to Resolved-Completed 

 The purchase order request is resolved, as shown in Figure 4-40. 
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Figure 4-40 Updated Process Diagram  

9. When the decision table rule returns a value of True, the Vice President’s approval is required. 
Add a connector from the VP Approve Order Decision shape to the VP Approval Assignment 
shape as shown in Figure 4-41. Click OK. 

 

Figure 4-41 Configure Connector  

10. From the VP Approval Assignment shape, add a connector to the Update Status Rejected 
Utility shape. 
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11. Double-click the connector to open the Connector Properties dialog. In the Flow Action field, 
press the down arrow, double-click More and then double-click to select Reject. 
 

 

Figure 4-42 Reject Flow Action 

12. In the Likelihood field, type 25 and click OK. PRPC uses the likelihood values to determine the 
order of actions in the action list in the user interface. 
 

 

Figure 3-43 Likelihood 

13. Add a connector from the VP Approval Assignment shape to the Update Status Completed 
Utility shape. Configure the connector as show in Figure 4-44. 
 

 

Figure 4-44 Configure Connector 
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14. Click to save your changes to the process.  
 

 

Figure 4-45  Updated Process Diagram 
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Test Your Process Changes 
Test your process changes using the Run menu.  

1. Click the Run icon  in the Quick Launch bar, select Run Process and select Purchase 
Order. You do not need to log out, but can act as the work user, manager, and VP. 
 

 

Figure 4-46 Run Menu 

2. Create a new purchase order request, using data values similar to those entered in the example 
in Chapter 3.  

3. Enter line items and quantities that produce a total amount that meets one of the criteria for 
requiring VP approval as shown in the table in Figure 4-1. For example, if the Department is IT, 
any order over $1000 requires the VP’s review. 

4. Click Submit to confirm the purchase order request.  

5. Click the Approve Order link displayed at the bottom of the confirmation note that indicates 
the purchase order is assigned to the manager (Figure 4-47). As a manager, approve the 
request. 

 

Figure 4-47. Approve Order Link 

6. Verify that after the manager approves the purchase order request, the request is routed to 
the Vice President for approval (Figure 4-48). 

 

Figure 4-48 Routed for VP Approval 
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Of course, more complete testing of every condition in the decision table rule is required in real-
world development situations.  

You can log off now or continue with the next chapter. To log off, click the Logout link in the upper 
right area of the Designer Studio. 
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Chapter 5: Updating the User Interface 
Currently, the Vice President sees the same user interface as the manager when approving or 
rejecting a purchase order request. However, ASupply’s business policy requires the VP to enter an 
approval code. The business policy also gives the VP the option to enter a note about the approval. 

In this chapter you will enhance the user interface to enable the VP to enter these details. 

Building a New Flow Action rule 
Recall from Chapter 3 that assignments are points in the process that are to be handled by a 
person to provide input or take other actions. Rules known as flow actions determine which inputs 
are requested from the user in the work item form as the user completes the assignment. 

To provide the VP the opportunity to enter input during the VPApproval assignment, a new flow 
action rule is needed to implement those details. 

1. Log in as Designer with the password password. 

2. From the Application Explorer in the left panel, click the + icon to expand the PurchaseOrder 
class. 

3. Click the + icon to expand the  User Interface category, right-click Flow Action and select 
New from the context menu (Figure 5-1). 

  

Figure 5-1 Flow Action Context Menu 

4. The New flow action rule dialog opens (Figure 5-2). Specify the following: 

a. Keep the Applies To value as it is 

b. For the Action Name, type VPApprove 

c. For the RuleSet, select ASupply 

d. For the Version, select 01-01-02 



 
 

 
Fast Start Guide  

52 

 

Figure 5-2 New Flow Action Dialog 

5. Click Create to create the new VPApprove flow action and display the rule form. In the 
Short Description field, insert a space between VP and Approve. The label, VP Approve, 
will display in the flow action section. 
 

 

Figure 5-3 VPApprove Flow Action Rule   

6. Click Save . At this point the new VPApprove flow action rule does not display user 
interface items for the VP to enter information. Section rules are used to implement user 
interface features for a flow action. Next, you will create a section rule. 

  



 
 

 
Fast Start Guide  

53 

Building a Section rule 
1. From the Application Explorer, click the + icon to expand the PurchaseOrder class. 

2. Click the + icon to expand the  User Interface category, right-click Section, and select 
New from the context menu (Figure 5-4). 
 

 

 Figure 5-4 Section Context Menu 

3. The New section rule dialog opens (Figure 5-5). Specify the following: 

a. Keep the Applies To value as it is 

b. For the Purpose, enter VPApproval 

c. For the RuleSet, select ASupply 

d. For the Version, select 01-01-02 

  

    Figure 5-5 New Section Dialog 

 

4. Click Create to create the new VPApproval section and display the rule form in the Designer 
Studio (Figure 5-6). An initial layout appears on the Layout tab.  
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5. Click Save to save the VPApproval section rule. 
 

 

  Figure 5-6 VPApproval Section Rule Form 

6. Add a field in which the VP is required to enter an approval code. To do this, click the Basic 

icon  in the toolbar, select the Text Input Control and drag it to the Field column cell 
in the top row, as shown in Figure 5-7. 
 

 

  Figure 5-7 Text Input Control 

7. In the Field column, click the magnifying glass icon  in the first row to open the Cell 
Properties panel. In the Property field, type .ApprovalCode (using the exact case and being 
sure to include a leading period).  
 

 

   Figure 5-8 Cell Properties Panel 

8. Click the Open icon  next to the Property field (Figure 5-8). This opens a New property 
rule dialog (Figure 5-9). 
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Figure 5-9 New Property Dialog 

9. Make sure that ASupply is selected in the RuleSet field and that 01-01-02 is selected in 
the Version field. Click Quick Create to create the new property rule (Figure 5-9). 

10. In the Cell Properties panel, select the General tab, and then select the Required 
checkbox. This ensures that a value is entered in the user form before it is submitted. 
Otherwise, an error message appears and reminds the user to enter a value. Close the Cell 
Properties panel. 
 

 

Figure 5-10 Select the Required Check Box 

11. In the Label column, click the magnifying glass icon next to Text Input to open the Cell 
Properties panel. In the Cell Properties panel, change the Value from Text Input to 
Approval Code, as shown in Figure 5-11. On the General tab, notice that the Required 
checkbox is selected. A required icon ( ) will display next to the label in the user interface. 
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Close the Cell Properties panel. 

 

Figure 5-11 Change the Value 

12. Select the Approval Code cell and then click the Insert Row After icon  to insert a row 
below Approval Code. 
 

 

Figure 5-12 Insert Row After 
 

 

Figure 5-13 New Rows Added to the Layout 
 

13. A property rule named PaymentDate already exists. You can drag and drop it from the 
Application Explorer into the new row below Approval Code. In the Application Explorer, 
click the + icon to expand the PurchaseOrder class, and then click the + icon to expand 
the  Data Model category to see the Property rule type. 

14. Click the + icon to expand the Property rule type (Figure 5-14). A blue dot   identifies a 
simple property rule, one that holds only a single value such as a date or amount. Other 
icons in this tree, such as , identify aggregate properties which are similar to arrays and 
structures. 
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Select the blue dot to the left of the PaymentDate link.  Do not click the PaymentDate 
link.  
 

 

Figure 5-14 Payment Date Property 

The blue dot turns yellow, indicating that it is selected. Drag and drop it into the second row 
of the Field column. 
 

 

Figure 5-15 Drag and Drop .PaymentDate Property 

This row now contains the .PaymentDate property. Notice the calendar icon in the Field 
column. This indicates that the .PaymentDate property is a pxDateTime Control. PRPC 
supports a wide variety of input and output formats for dates and times. 
 

 

Figure 5-16  .PaymentDate pxDateTime Control 
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15. In the Label column, click the magnifying glass icon  next to PaymentDate to open the 
Cell Properties panel. Change the Value to Payment Date by inserting a space.  Close the 
Cell Properties panel. 
 

 

Figure 5-17 PaymentDate pxDateTime Control 

16. From the Basic panel, drag a Text Area Control to the cell in the third row of the Field 
column. 
 

 

Figure 5-18 Add the Text Area Field 

17. In the Label column, click the magnifying glass icon next to the Text Area cell to open 
the Cell Properties panel. Change the Value to Note and close the Cell Properties panel. 
 

 

Figure 5-19 Change the Text Area Label 

18. In the toolbar, click Save to save the updated VPApproval section rule. 

19. Click the Preview button in the toolbar to view the effect of your changes in the bottom 
half of the portal (Figure 5-20). 
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Figure 5-20 Preview  

20. Click the x on the VPApproval tab to close the section rule. 
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Adding a Section rule to a Flow Action 
Now that the section is created, add it to the VPApprove flow action so that the Approval Code 
and Note user interface elements display as the VP completes the assignment. 

1. Return to the VPApprove flow action rule by clicking its tab in the Designer Studio (Figure 5-
21). 

  

Figure 5-21 VPApprove Flow Action Rule Form 

2. In the Application Explorer, expand the Section rule type to locate the newly created 
VPApproval section. Select the blue dot  to the left of the VPApproval section. A blue dot 
identifies a single rule. The blue dot turns yellow, indicating that it is selected. Drag it into the 
VPApprove flow action rule, dropping it onto the <drag section here> area (Figure 5-22). 

  

Figure 5-22 Drag VPApproval Section into VPApprove Flow Action 

3. When you release the mouse button, the VPApprove flow action rule displays a section 
reference to the VPApproval section (Figure 5-23). 
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Figure 5-23 VPApprove Flow Action with Section Reference to VPApproval 

4. Save the VPApprove flow action by clicking . 

5. Click the x on the VPApprove tab to close the VPApprove flow action rule. 

Editing the Flow  
At this point, the new flow action VPApprove is complete, but not referenced by any shape in the 
flow rule. In this section you will update the PurchaseOrder flow rule so that the new VPApprove 
flow action runs when the VP approves a purchase order request.  

1. Open the PurchaseOrder flow using the Application Explorer. 

2. Double-click the Manager Approve connector to display the Connector Properties. 
 

 

Figure 5-24 Manager Approve Connector 

3. In the Connector Properties panel, type VP Approve in the Name field, use the SmartPrompt 
to replace ManagerApprove with VPApprove. Click OK (Figure 5-25). 
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Figure 5-25 VP Approve Connector Properties 

 
The connector in the process diagram is labeled VP Approve. 
 

 

Figure 5-26 VP Approve Connector 

4. Click Save to save your changes to the flow rule. 

5. Test the revised process to verify that the VP is now required to enter an Approval Code and an 
optional note when approving a purchase order request. 

a. Click the Run icon  in the Quick Launch bar and select Run Process > Purchase 
Order. 

b. Create a purchase order request that requires VP approval. The requirements are stated 
in the decision rule table you created in Figure 4-29. For example, enter HR as the 
Department Name and select one laptop, which requires VP approval because it is over 
$500. 

c. As manager, approve the request. It is now assigned to the VP. 
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Figure 5-27 VP Approval Pending 

The VP is now required to enter an approval code and may also enter an optional note 
(Figure 5-28). 

  

Figure 5-28 Approval Code  

d. Enter a note and click Submit to finish the process. 

Inspecting Declarative Rules 
The application calculates several properties with declarative rules, which are rules that define 
calculations among property values. For example, each LineItemTotal is the value of the item’s 
Price multiplied by Quantity. 

To see the list of declarative rules, go to the Application Explorer, select the ACORP-FW-ASupply-
Work class, expand the Decision category  and  expand the Declare Expressions category as 
shown in Figure 5-29. 

 

Figure 5-29 Declare Expressions in Application Explorer 
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To open a rule from the Application Explorer, click the rule name. Figures 5-30 and 5-31 show the 
.OrderTotal and LineItemTotal.Order() rule forms respectively.  
 

  

Figure 5-30 Declarative Expression for .OrderTotal  

  

Figure 5-31 Declarative Expression for .LineItemTotal  

Like formulas in a Microsoft Excel spreadsheet, properties controlled by declarative rules are 
computed automatically whenever a value changes that affects the computation. For example, the 
target property .LineItemTotal is computed whenever the Price or Quantity changes. Similarly, you 
don’t need to create an explicit program to recalculate the .OrderTotal after you input a quantity.  

Using the Declarative Rules Inspector 
You can use the Declarative Rules Inspector to see which properties in the work item form are 
dependent upon these rules, and to graphically illustrate those dependencies. 

1. To enable the Declarative Rules Inspector, click the  Run icon in the Quick Launch bar and 
select Rules Inspector > Declarative Rules (Figure 5-32). 

  

Figure 5-32 Declarative Rules Inspector 
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2. Create a new purchase order request by selecting  > Run Process > Purchase Order. On 
the work item form, a D link appears next to each property that is calculated by a declarative 
rule. 

For example, assume that you select the Laptop item and type 2 as the quantity. Notice that a 
D appears next to the .LineItemTotal property (Figure 5-33). Click the “D” link to inspect how 
that property value is calculated. 

  

Figure 5-33 Reviewing Declarative Rules  

After clicking the D, the Dependency Network Viewer opens and shows the Dependency 
Network for the .LineItemTotal property (Figure 5-34). 

  

Figure 5-34  Dependency Network Viewer  

The symbols shown in the viewer are described below: 

• A function symbol ( ) references a declarative rule 
• The arrows show how computations depend on each other – where results from one 

computation feed into inputs of a later computation 
  

PRPC supports complex declarative rules and enables you to test and debug declarative 
computations interactively.  

To disable the Declarative Rules Inspector feature, click  > Rules Inspector > Declarative 
Rules.  
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Chapter 6: Reviewing Your Application 
By following Chapters 4 and 5 in this tutorial, you used rule forms and the Process Modeler to 
refine the ASupply application. PRPC uses sophisticated industry-standard technologies to 
implement your changes without requiring you to directly specify coding-level details. You do not 
need advanced IT skills to produce applications that are functional, easy to use, and visually 
appealing. 

Developing Applications by Changing Rules  
You created a few new rules in the ASupply RuleSet that include: 

 A decision table rule, VPApproveOrder, that controls which purchase order requests are 
routed to the VP for review 

 A property rule, ApprovalCode, that holds an input value entered by the Vice President 
 A flow action rule, VPApprove, that prompts the VP with two new fields after the VP 

approves a purchase order request. 
 A section rule, VPApproval, that provides the user interface for the VPApprove flow action. 

 

These new rules supplemented the original set of rules in the ASupply RuleSet, which defined the 
application before you changed it. As you will see in Chapter 7, Documenting Your Application, and 
from the application document in Appendix A, the ASupply RuleSet contains about 125 rules. 

The Application Explorer provides designers and developers with quick access to rules in the 
ASupply RuleSet. These rules, in turn, build on hundreds of built-in, out-of-the-box standard rules 
that are present in every PRPC system and which form the foundation building blocks of 
applications. 

Technology Under the Covers  
If you are familiar with the technologies mentioned below, you can appreciate the power and 
breadth of PRPC as a development environment. 

 A property rule (for example, the ApprovalCode property) corresponds to a scalar variable. 
 Flow action rules are converted to HyperText Markup Language (HTML). 
 The Process Modeler representation of a business process is converted internally to an XML 

(eXtended Markup Language) document that later becomes a Java class. 
 Rules and other data are stored in a relational database supported by any of several popular 

database products from Oracle, Microsoft, or IBM. 
 Computations, such as declarative rules and decision table rules, are transformed into 

efficient Java programs. 
 Autogenerated Controls simplify design and maintenance, eliminating the need for hand-

coding, improving performance, and ensuring browser independence and compatibility. 
 Grid layouts enable users to view and edit values of a Page List or Value List property or a 

Report Definition in a spreadsheet format. Grids are created dynamically and have as many 
rows as needed to display the requested data. 
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The architecture and design of PRPC provides these benefits. 

 Inheritance and polymorphism enable you to build applications by overriding or extending 
existing rules. For example, the flow rule that you saved into the higher RuleSet Version 
overrides (supersedes) the initial flow rule that was delivered with the ASupply application. 

 Through hardware clustering, one PRPC system can support thousands of users in multiple 
locations who enter, work on, and resolve millions of work items. 

 Applications can be developed iteratively with incremental enhancements. 
 Developers can use the Run menu in the Quick Launch bar to quickly switch from a 

development task to a testing task and back to a development task, as you did. 
 PRPC applications can interface with other systems using a wide variety of industry-

standard technologies such as SOAP / Web services, e-mail, relational databases, J2EE 
facilities including Enterprise JavaBeans, and JavaServer Pages.  
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Chapter 7: Documenting Your Application  
PRPC includes a tool that enables you to easily document what you have built. This chapter shows 
you how to use that tool – the Application Documentation Wizard. 

Note:  Office 2010 64-bit is not supported for use with PRPC.  If your client uses Word 2010 64-bit, you 

cannot generate a document using this wizard. 

Documenting the ASupply Application 

1. In the Designer Studio, select    > Application > Tools > Document option (Figure 7-1). 
 

 

Figure 7-1 Document Tool Selection 
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2. In the Application Document wizard, select the ASupply application, the ASupply application 
template, and specify the Detail Level.  For this exercise, select Full Application 
Documentation.  
For detailed information about using the Application Document wizard, click the Help button 

 in the upper right of the wizard. 
 

 

Figure 7-2  Application Document Wizard  

3. Click the Order chevron at the top of the screen to move directly to that documentation step.   

In this exercise we will skip the Define and Capture steps where you can elect to include Entity 
Relationship Diagrams and Capture screenshots in the document. 
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Figure 7-3 Order Chevron  
 

4. In this step, you select the application items that you want to include in the document.  Leave 
all items selected. 

  

Figure 7-4 Order Step 

5. Now that you have specified the information that you want to include in the Word document, 
click the Document Now button at the bottom of the screen.  
 

 

Figure 7-5 Document Now Button  

PRPC launches Microsoft Word and generates a document that lists all of the rules in the 
application. The generation process may take a minute or two. A message box displays when 
the documentation is complete.  
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Figure 7-6 Document Done Message  

6. You can save the Word output into a location of your choice.  

Appendix A of this guide contains a sample of the document output created by the wizard for 
the ASupply application. 

7. Click the Logout link in the upper right corner of the Designer Studio. 

 

Congratulations!  You have completed the Fast Start tutorial.   
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Appendix A: Application Document for ASupply 
This appendix contains a copy of the Word document created by PRPC for the ASupply application 
using the process described in Chapter 7. 
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Application Document for ASupply 01.01.01 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

Created by: Designer  
On November 13, 2012  
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 Copyright 2013 
 

Pegasystems Inc., Cambridge, MA 

All rights reserved. 
This document describes products and services of Pegasystems Inc. It may contain trade secrets 
and proprietary information. The document and product are protected by copyright and distributed 
under licenses restricting their use, copying distribution, or transmittal in any form without prior 
written authorization of Pegasystems Inc.  
 
This document is current as of the date of publication only. Changes in the document may be made 
from time to time at the discretion of Pegasystems. This document remains the property of 
Pegasystems and must be returned to it upon request. This document does not imply any 
commitment to offer or deliver the products or services described.  
 
This document may include references to Pegasystems product features that have not been 
licensed by your company. If you have questions about whether a particular capability is included 
in your installation, please consult your Pegasystems service consultant.  
 
For Pegasystems trademarks and registered trademarks, all rights reserved. Other brand or 
product names are trademarks of their respective holders. 
 
Although Pegasystems Inc. strives for accuracy in its publications, any publication may contain 
inaccuracies or typographical errors.  This document or Help System could contain technical 
inaccuracies or typographical errors. Changes are periodically added to the information herein. 
Pegasystems Inc. may make improvements and/or changes in the information described herein at 
any time. 
 
 
This document is the property of: 
Pegasystems Inc. 
One Rogers Street 
Cambridge, MA  02142-1590 
 
Phone: (617) 374-9600 
Fax: (617) 374-9620 
www.pega.com 
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1 Application Overview 
 

1.1 Description 
Initial implementation of a system that will centralize and automate the purchasing function for corporate employees.  
 

1.2 Business Objectives 

• Centralize the purchasing function for employees across the corporation 
• Automate decisioning and routing of purchase orders 

1.3 Actors 
Actor Type Count Access Method 

Employee Operator 2000 Total Users Per Week Browser 

Manager Operator 50 Total Users Per Week Browser 

 

1.4 Case Type Definitions 
Case Type Prefix  Starting Process  

Work Pool: ASupply  C-   

         ASupply  C-  No Processes Defined.  

                  Purchase Order  P-  Purchase Order  

 

1.5 Work Types 
Name Implementation Class 

PurchaseOrder ACORP-FW-ASupply-Work-PurchaseOrder 

 

1.6 Supporting Types 
Name Description 

Common Specifications shared by multiple work types 

Security Specifications dealing with authentication, authorization 

Navigation Specifications specific to getting between work types and general application processing 

DataManagement Specifications specific to managing lists of products, reference data tables, broadcast messages 

SysAdmin Specifications specific to managing operator profiles, calendars, skills, rule migration/promotion 
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1.7 RuleSets 
RuleSet Version Description Prerequisites 

ASupply 01-01-02 RuleSet to identify, manage, and control the set of rule 
instances that define ASupply application 

Pega-ProcessCommander:06-03-01 
ASupplyInt:01-01-01 

ASupplyInt 01-01-01 Integration RuleSet for ASupply framework Pega-ProcessCommander:06-03-01 
ACORP:01-01-01 

ACORP 01-01-01 Created by Initial Setup Wizard Pega-ProcessCommander:06-03-01 

ACORPInt 01-01-01 ACORPInt Pega-ProcessCommander:06-03-01 

 

1.8 Requirements 
ID Name Category Status Description 

ApprovalLevel ApprovalLevel Business 
Rule 

Complete Pruchase requests are routed to managers based on total dollar values as described in the 
corporate accounting manual 

PurchaseItems PurchaseItems Business 
Rule 

New The list of items an employee can request is based on the employee's grade level. 

RejectReason RejectReason Business 
Rule 

New A list of reject reasons is presented to managers and fulfillment operators who select from the 
list.   
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2 PurchaseOrder 
Implementation: ACORP-FW-ASupply-Work-PurchaseOrder  

 2.1 Purchase Order - Flow 
 
Flow Diagram 

 

2.1.1 Primary Path 

2.1.1.1 Enter Item Information - Transition 
Implementation: EnterItemInformation 
Referenced By: Purchase Order - Flow (Page 78) 

2.1.1.2 Confirm Order - Transition 
Implementation: ConfirmOrder 
Referenced By: Purchase Order - Flow (Page 78) 

2.1.1.3 Manager Review - Decision 
Implementation: ManagerReview 
Referenced By: Purchase Order - Flow (Page 78) 
 
• if .OrderTotal > 100 then RETURN review  
noreview  
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2.1.1.4 VP Approve - Transition 
Implementation: VPApprove 
Referenced By: Purchase Order - Flow (Page 78) 

2.1.1.5 VP Approve Order - Decision 
Implementation: VPApproveOrder 
Referenced By: Purchase Order - Flow (Page 78) 

 Conditions   Actions  

  DepartmentName  BillCustomer  OrderTotal   Return 

  =  =  =    

if  IT  >1000  True 

else if  HR  >500  False 

else if  Finance =False   True 

else if  Finance =True >200  True 

else if  Legal =True >500  True 

else if  Legal =False >200  True 

Otherwise     False 

2.1.2 Alternate Path 1 

2.1.2.1 Reject - Transition 
Implementation: Reject 
Referenced By: Purchase Order - Flow (Page 78) 
Long Description: This flow action is for rejecting the work object. 
Usage: Used by the StandardEvaluate flow. Approval flows should use the Disapprove flow action, not Reject. 

2.1.3 Alternate Path 2 

2.1.3.1 Reject - Transition 
Implementation: Reject 
Referenced By: Purchase Order - Flow (Page 78) 
 
See Reject (Page 79) 
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Other Specifications referenced in the application (outside of a Process) 

2.1.4 RejectOrder - Specification 
 
Details  

Actors:    Manager 

Triggers:  Web Browser 

Complexity:  Low 
 

Description 

Not yet defined  

2.1.5 PurchaseOrder - Specification 
 
Details  

Actors:    Any 

Triggers:  Web Browser 

Complexity:  Low 
 

Description 

Enter department information  

2.1.6 EnterItemInformation - Specification 
 
Details  

Actors:    Employee 

Triggers:  Web Browser 

Complexity:  Medium 
 

Description 

Enter the items to purchase.  

2.1.7 EnterDeptInformation - Specification 
 
Details  

Actors:    employee 

Triggers:  Web Browser 

Complexity:  Low 
 

Description 

Department information is defaulted into the purchase request  form but the employee can overwrite it if not correct.  
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2.1.8 ConfirmOrder - Specification 
 
Details  

Actors:    Employee 

Triggers:  Web Browser 

Complexity:  Low 
 

Description 

Not yet defined  

2.1.9 ApproveOrder - Specification 
 
Details  

Actors:    Manager 

Triggers:  Web Browser 

Complexity:  Medium 
 

Description 

Manager must approve order totaling more than $100  

 

3 Common 

Description: Specifications shared by multiple work types 
   

4 Security 

Description: Specifications dealing with authentication, authorization 
   

5 Navigation 

Description: Specifications specific to getting between work types and general application 
processing 
   

6 DataManagement 

Description: Specifications specific to managing lists of products, reference data tables, broadcast 
messages 
   

7 SysAdmin 

Description: Specifications specific to managing operator profiles, calendars, skills, rule 
migration/promotion 
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8 Requirement Matrix 
Requirement Category External ID Status Description Linked To 

ApprovalLevel Business Rule  Complete ApprovalLevel ASupply 

PurchaseItems Business Rule  New PurchaseItems ASupply 

RejectReason Business Rule  New RejectReason ASupply 
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Appendix B: Installing the ASupply Application 
This Appendix describes how to install the ASupply application. You can download the the 
Fast_Start_63SP1.zip and import the ASupply application into PRPC. 

The Fast_Start_63SP1.zip file contains two files: 

■ ASupply_V63.jar — the application archive to import into PRPC 

■ Fast_Start_Guide_63SP1.pdf — this guide to working with PRPC and the ASupply 
application 

Installing the ASupply Application 

The following procedure describes how to import the ASupply application into your PRPC system.  

Depending upon the state of your database, PRPC windows may appear differently. To install the 
ASupply application, browse to the location of the ASupply_V63.jar file, and then click Next 
throughout the Import wizard to accept the defaults. 

1. Open the Fast_Start_63SP1.zip and save the files to your local directory. 

2. Log into your PRPC system using an operator ID and password that has the appropriate privileges 
to import rules (for example, privileges similar to those given by the PegaRULES:SysAdm4 access 
role). The Designer Studio opens. 

3. In the Designer Studio, select the Pega button ( ) and then click Application > Distribution > 
Import (Figure D-1). 

 
                  Figure D-1. Designer Studio Import 
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4. Browse to the ASupply_V63.jar file and then click Next (Figure D-2). 
 
 
 
 
 
 
 

Figure D-2. Browse to .jar file 

5. Verify that ASupply_V62SP2.jar is selected and then click Next (Figure D-3). 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure D-3. Click Next 
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6. Click Next to update the database schema (Figure D-4). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
              Figure D-4. Update database schema 

7. When the import to the database is complete, click Next (Figure D-5).  

8. Data is saved to the database. This may take a few moments. When this is complete, click 
Done (Figure D-6). 
 
 
 
 
 
 
 

                  Figure D-5. Import complete 

9. Log-out of PRPC. The ASupply application is ready to use in the hands-on exercise, beginning 
in Chapter 3 of this guide. 
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Appendix C: Contacting Pegasystems 
This appendix provides Pegasystems contact information for: 

 Education services 
 Documentation feedback 

Education Services 
Pegasystems’ University of Pega offers a wide range of self-study and instructor led training 
courses for our customers. For course descriptions and contact information, go to 
http://pega.com/services/university-of-pega/pega-education-services.  

Documentation Feedback 
Pegasystems strives to provide high-quality documentation. If you have comments or suggestions 
about this guide or the sample ASupply application, send us an email at docteam@pega.com.  
Include the following information: 

 Document name, version number, and date it was updated – this information is located at 
the bottom of the copyright page 

 Page number 
 Brief description of the problem  

 
For more information about Pegasystems and its products, visit our Web site at www.pega.com. 

 

http://pega.com/services/university-of-pega/pega-education-services
mailto:docteam@pega.com
http://www.pega.com/
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